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DO NOT USE THIS PRODUCT IN LIFE SUPPORT SYSTEMS.

LIFE SUPPORT POLICY

ZILOG’S PRODUCTS ARE NOT AUTHORIZED FOR USE AS CRITICAL COMPONENTS IN LIFE 
SUPPORT DEVICES OR SYSTEMS WITHOUT THE EXPRESS PRIOR WRITTEN APPROVAL OF 
THE PRESIDENT AND GENERAL COUNSEL OF ZILOG CORPORATION. 

As used herein

Life support devices or systems are devices which (a) are intended for surgical implant into the body, or (b) 
support or sustain life and whose failure to perform when properly used in accordance with instructions for 
use provided in the labeling can be reasonably expected to result in a significant injury to the user. A criti-
cal component is any component in a life support device or system whose failure to perform can be reason-
ably expected to cause the failure of the life support device or system or to affect its safety or effectiveness.

Document Disclaimer

©2016 Zilog, Inc. All rights reserved. Information in this publication concerning the devices, applications, 
or technology described is intended to suggest possible uses and may be superseded. ZILOG, INC. DOES 
NOT ASSUME LIABILITY FOR OR PROVIDE A REPRESENTATION OF ACCURACY OF THE 
INFORMATION, DEVICES, OR TECHNOLOGY DESCRIBED IN THIS DOCUMENT. ZILOG ALSO 
DOES NOT ASSUME LIABILITY FOR INTELLECTUAL PROPERTY INFRINGEMENT RELATED 
IN ANY MANNER TO USE OF INFORMATION, DEVICES, OR TECHNOLOGY DESCRIBED 
HEREIN OR OTHERWISE. The information contained within this document has been verified according 
to the general principles of electrical and mechanical engineering. 

Z8, Z8 Encore!, and Z8 Encore! XP are trademarks or registered trademarks of Zilog, Inc. All other prod-
uct or service names are the property of their respective owners. 

Warning:
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Revision History

Each instance in the Revision History table below reflects a change to this document from 
its previous version. For more details, click the appropriate links in the table.

Date
Revision 
Level Description Page

Sep 
2016

02 Removed RS-232 to 6-pin circuit adapter in the Kit Contents 3,12

Oct 
2013

01 Original issue. n/a
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Safeguards

The following precautions must be observed when working with the devices described in 
this document.

Always use a grounding strap to prevent damage resulting from electrostatic 
discharge (ESD).

Caution:
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The Z8 Encore! XP® F6482 Series 
Development Kit

This document describes how to set up the F6482 Series Development Kit (Zilog part 
number Z8F64820100ZCOG) and use it to evaluate your Z8F6482-based designs and 
applications. The Kit features a development board consisting of four LEDs, three push-
buttons, a buzzer/speaker, a 7.1 seven-segment LCD, a pyroelectric sensor, a phototransis-
tor, 32Mbit SPI Flash, port pin headers, and USB and UART ports. The Board features the 
Z8F6482 MCU in a 80-pin LQFP package, plus a DBG connector to connect the Board to 
a host development PC using Zilog’s USB SmartCable. To learn more about the Z8F6482 
MCU, refer to the F6482 Series Product Specification (PS0294).

This document provides instructions for setting up and configuring Z86482 Development 
Board and includes schematic diagrams and a discussion of Board features and ZDS II.

The first sections of this document guide you through the following tasks:

• Download and Install the ZDS II Software and Documentation – see page 4

– Installing the USB SmartCable Driver – see Appendix B. Installing the USB 
SmartCable Driver on page 36

• Connect the F6482 Series Development Board to your PC – see page 6

• Start the Z8F6482 Demonstration Program – see page 8 

Further details, including memory configurations, jumper settings, and a listing of sample 
projects can be found in the Z8F6482 Sample Projects section on page 30. 

Figure 1 shows an image of the F6482 Series Development Kit.

http://www.zilog.com/docs/ps0294.pdf
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Figure 1. The F6482 Series Development Kit
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Kit Contents

Table 1 lists the contents of the F6482 Series Development Kit.

Kit Features

The key features of the F6482 Series Development Kit are:

• F6482 Series Development Board, which includes:

– Z8F6482 MCU in an 80-pin LQFP package operating at 24 MHz with 64 KB of 
internal Flash memory and 3.75 KB of internal RAM memory

– 32 Mbit SPI Flash 

– A USB interface that provides: 

○ Power to the Board with overcurrent protection

○ Connection to the Z8F6482 MCU’s USB port 

– 7.1 segment LCD module

– Speaker: SP1

– Pyroelectric sensor

– Phototransistor

– UART(s) port J20

– Test points, headers, and prototype area

– External source of reference voltage (2.5 V)

– MCU current measurement test points J5 and J6

– Power supply level adjustable with potentiometer R13 

• USB SmartCable

• ZDS II software, samples, and documentation available free for download

– Z8F6482 Board Support Package (BSP) source code and sample programs

Table 1. Z8F64820100ZCOG Contents

Item Description Quantity

1 F6482 Series Development Board 1

2 USB SmartCable 1

3 6-circuit ribbon cable 1

4 A (male) to Mini-B USB cable 1

5 F6482 Series Development Kit Flyer (FL0160) 1
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Board Support Package

The ZDS II software download includes a Board Support Package (BSP) that provides an 
application programming interface (API) to configure and control select Z8F6482 MCU 
peripherals. This BSP API is accessible through a static library linked to customer applica-
tions and is a blend of macros and C functions that facilitate application development by 
abstracting direct SFR manipulation from the programmer. Macros provide near-assem-
bly-level access to SFRs without incurring the overhead (i.e., code size and execution 
time) of C functions for basic operations (e.g., stopping a timer). More complex operations 
are implemented in C functions, thereby eliminating the customer requirement for recreat-
ing code for frequently-used operations (e.g., transmitting a block of data through the 
UART under DMA control). By using the BSP library, customers can develop applications 
that access Z8F6482 MCU peripherals with only a few function calls, effectively reducing 
development effort to a minimum.

The ZDS II software download also includes complete source code to all peripheral 
devices supported by the BSP API. Advanced programmers can cut and paste code snip-
pets from the BSP into their own applications, or simply study the BSP source code to 
gain a better understanding of the Z8F6482 Series of MCUs.

To learn more about the BSP API, refer to the F6482 Series Board Support Package Refer-
ence Manual (RM0064).

Supported Operating Systems

The F6482 Series Development Board supports the following operating systems:

• Microsoft Windows 8 (32-bit/64-bit)

• Microsoft Windows 7 (32-bit/64-bit) 

• Microsoft Windows Vista (32-bit/64-bit) 

• Microsoft Windows XP

Download and Install the ZDS II Software and Documenta-
tion

Observe the following steps to install your ZDS II software and documentation.

http://www.zilog.com/docs/rm0064.pdf
http://www.zilog.com/docs/rm0064.pdf
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If you have already installed ZDS II – Z8 Encore! <version> and have downloaded the soft-
ware and documentation by following the procedure on the paper insert in your kit 
(FL0160), you’re ready for Appendix B. Installing the USB SmartCable Driver on page 36.

1. Prior to connecting the F6482 Series Development Board to your development PC, 
download ZDS II for Z8 Encore! v5.2.2 (or later) from the Downloadable Software 
category in the Zilog Store; see Figure 2.

2. When your download is complete, double-click the installation file named 
ZDS2_Z8Encore!_<version>.exe, and follow the on-screen instructions.

Figure 2. The Downloadable Software category in the Zilog Store

Note:
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Connect the F6482 Series Development Board to your PC

Observe the following procedure to connect the F6482 Series Development Board to your 
PC.

Disconnect or turn off the power to the F6482 Series Development Board before con-
necting or disconnecting the USB SmartCable.

1. Ensure that the following F6482 Series Development board default jumper settings 
are configured (see Table 5 on page 31 for reference):

J1 IN

J2 OUT

J9 IN 

J19 OUT

J21 1-2 IN

J21 5-6 IN

J23 1-2 IN 

2. Connect one end of the 6-circuit ribbon cable provided in your Kit to the USB Smart-
Cable unit, ensuring that the ribbon’s male connector is aligned correctly with the 
female connector on the unit, as indicated by the red stripe in Figure 3.

Figure 3. Connecting the 6-Circuit Ribbon Cable to the USB SmartCable

Caution:
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3. Connect the other end of the ribbon cable to Debug Connector J16 on the Develop-
ment Board. Ensure that Pin 1 on the ribbon cable is aligned with Pin 1 on the target 
connector, as highlighted in Figure 4.

Figure 4. Debug Connector J16
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4. With the USB A (male) to Mini-B cable, connect Port P1 on the F6482 Series Devel-
opment Board to a USB port on the development PC to apply power to the Develop-
ment Board, as highlighted in Figure 5.

Start the Z8F6482 Demonstration Program

The F6482 Series Development Kit includes a sample program that demonstrates a blink-
ing LED application. An optional terminal emulation program and a 3rd Party USB to 
TTL Serial converter (not supplied) maybe used and must be configured for 57600-8-N-1 
with no flow control, as described in the HyperTerminal Configuration section on page 12. 
To get started with the Z8F6482 demonstration, observe the following procedure.

1. Launch ZDS II by navigating from the Windows Start menu to Programs → Zilog 
ZDS II – Z8 Encore! <version> → ZDS II – Z8 Encore! <version>.

2. From the File menu in ZDS II, select Open Project as shown in Figure 6, and navigate 
via the following filepath.

<ZDS Install>\samples\XP_F6482\XP_F6482_LedBlink_C

Figure 5. Power Supply Port P1 Connector
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3. Select the ledblink.zdsproj project from within the XP_F6482_ledBlink_C 
folder and click Open, as shown in Figure 7. A list of source files will appear in the 
workspace panel.

Figure 6. Open Project from the ZDS II File Menu

Figure 7. Select the ledblink.zdsproj Project
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4. From the Build menu, select Set Active Configuration to open the Select Configura-
tion dialog box.

5. Select Debug, then click OK to close the Select Configuration dialog box.

6. From the Project menu in ZDS II, select Settings to open the Project Settings dialog 
box. In the Project Settings dialog box, click the Debugger tab.

7. On the Debugger page, select Z8F64820100ZCOG from the Target list, then select 
USB SmartCable from the Debug Tool drop-down menu, as shown in Figure 8.

8. Click OK to close the Project Settings dialog box.

9. If you are prompted to rebuild any affected files, click Yes. Otherwise, choose Build
from the menu bar, then click Rebuild All.

10. To run the application, select Go from the Debug menu, as indicated in Figure 9. As a 
result, LEDs D4, D5, and D6 will blink in sequence.

Figure 8. Select Z8F64820100ZCOG and USB SmartCable
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11. After the application has started, console output should be visible in the terminal emu-
lation program, as shown in Figures 10 and 11.

Figure 9. Select Go from the Debug Menu

Figure 10. Console Output Using Hyperterminal (Windows XP)
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HyperTerminal Configuration

A communications program such as HyperTerminal can be used on Windows XP systems 
to view messages from the F6482 Series Development Board. The following procedure 
examines how to configure HyperTerminal for the Z8F6482 demonstration project.

The HyperTerminal application is not available in Windows Vista and Windows 7 systems. If 
you are using either of these operating systems, consider using/installing different communica-
tion software such as Tera Term; see Appendix C. Tera Term Configuration on page 39.

1. Connect a 3rd Party USB to TTL Serial converter to J20 on the Development Board
using the connections shown in Table 2.

Figure 11. Console Output Using Tera Term (Windows 7)

Note:
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2. Connect the other end to your PC.

3. In HyperTerminal, choose File Properties; then, if your PC has a serial interface, 
select the COM port assigned to your serial port. If you do not have a serial port on 
your PC, use a USB-to-serial adapter (not included in the kit). 

4. From the Windows Control Panel, navigate via the Device Manager to Ports (COM & 
LPT) to determine the correct COM port assigned to your adapter. Configure this port 
to reflect the following settings:

– 57600 bps 

– 8 data bits 

– No parity 

– 1 stop bit

– No flow control 

5. In HyperTerminal, click the Call button to connect to the F6482 Series Development 
Board. When connected, you should be able to see the demonstration program menu 
shown in Figure 11. 

F6482 Series Development Board

The purpose of the F6482 Series Development Kit is to provide a set of hardware and soft-
ware tools for applications based on the Z8F6482 microcontroller. An image of the F6482 
Series Development Board is shown in Figure 12; a block diagram is shown in Figure 13.

Table 2. USB to TTL Serial Converter Connections

Z8F6482 Board USB to TTL Serial Converter

J20-1 VCC 5V

J20-4 RXD TXD

J20-5 TXD RXD

J20-6 GND GND
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Figure 12. The F6482 Series Development Board
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Power Sources

The Board features two power source options. It can be powered by connecting Port P1 
(USB Mini-B) to the USB port of the development PC using the USB A-to-USB Mini-B 
cable included in the Kit. The other option is to connect an external 5 VDC source with at 
least 300–400 mA of current to J14 (5 VDC) and J15 (GND).

• USB power at P1

• External power across J14 and J15

Z8F6482 MCU Features

The Z8F6482 MCU is a member of Zilog’s Z8 Encore! XP Family of microcontroller 
products. Key features include: 

• 24 MHz eZ8 CPU core

Figure 13. F6482 Series Development Kit Block Diagram
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• 16 KB, 32 KB, 60 KB or 64 KB Flash memory with in-circuit programming capability 

• 2 KB or 3.75 KB internal RAM 

• 128 B Non-Volatile Data Storage (NVDS) 

• Up to 17-channel, 12-bit Analog-to-Digital Converter (ADC) that can be configured 
for internal or external voltage reference and single-ended or differential inputs

• 12-bit Digital-to-Analog Converter (DAC) 

• Integrated LCD driver with blinking and contrast control for up to 96 segments 

• 128-bit Advanced Encryption Standard (AES) encryption/decryption hardware accel-
erator according to FIPS PUB 197 

• Real-Time Clock (RTC) supporting both Counter and Clock modes 

• On-chip temperature sensor

• Two on-chip analog comparators (32-pin and 64-pin with LCD packages contain only 
one) 

• Two on-chip, low-power operational amplifiers (32-pin and 64-pin with LCD pack-
ages contain only one) 

• 8-channel event system provides communication between peripherals for autonomous 
triggering 

• Full-speed Universal Serial Bus (USB 2.0) device supporting eight endpoints with 
integrated USB PHY (not available on 64-pin package with LCD)

• Two full-duplex 9-bit UART ports with the support of Local Interconnect Network 
(LIN) and Digital Addressable Lighting Interface (DALI) protocols (32-pin and 64-
pin with LCD packages contain only one)

• RS-485 Multidrop Mode up to 250 Kbit/sec (DMX support) integrated with UARTs

• Two Enhanced Serial Peripheral Interface (ESPI) controllers (32-pin and 44-pin pack-
ages contain only one)

• I2C controller which supports Master/Slave modes 

• Four-channel DMA controller 

• Three enhanced 16-bit timers with Capture, Compare, and PWM capability 

• Two additional basic 16-bit timers with interrupts (shared as UART Baud Rate Gener-
ator)

• 16-bit multi-channel timer which supports four Capture/Compare/PWM modules (not 
available on 32-pin and 64-pin with LCD packages) 

• Watchdog Timer (WDT) 

• 26 to 67 General-Purpose Input/Output (GPIO) pins, depending upon package 
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• Up to 41 interrupt sources with up to 30 interrupt vectors 

• On-Chip Debugger (OCD) 

• Power-On Reset (POR) and Voltage Brown-Out (VBO) protection 

• Built-in Low-Voltage Detection (LVD) with programmable voltage threshold 

• Low Frequency Crystal Oscillator (LFXO) operating at 32.768 kHz with low power 
consumption 

• Internal clock sources and clock multiplication, including an Internal Precision Oscil-
lator (IPO), Digitally Controlled Oscillator (DCO), Watchdog Timer Oscillator 
(WTO), Frequency Locked Loop (FLL) and Phase Locked Loop (PLL) 

• High Frequency Crystal Oscillator (HFXO) operating in the 1–25 MHz range 

• Wide 1.8 V–3.6 V operating voltage range

• 32-, 44-, 64-, and 80-pin packages 

• –40°C to +85°C (extended) operating temperature range 

To learn more, refer to the F6482 Series Product Specification (PS0294).

SBLCDA4 LCD

The seven-segment LCD panel used at LCD1 on the F6482 Series Development Board is 
an SBLCDA4 device manufactured by Softbaugh. The display footprint and pin labels for 
this device are shown in Figure 14.

http://www.zilog.com/docs/ps0294.pdf
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The pin configuration of LCD1, as connected to the Z8F6482 MCU’s pins, is shown in 
Figure 15.

Figure 14. Seven-Segment LCD from Softbaugh

Figure 15. LCD1 Pin Configuration
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Figure 16 shows an image of the SBLCDA4 LCD device mounted on the F6482 Series 
Development Board.

Table 3 presents a pin map of the LCD1 device.

To learn more about this SBLCDA4 LCD device, visit http://www.softbaugh.com/down-
loads/SBLCDA4_Specification.pdf.

Figure 16. LCD1 on the F6482 Series Development Board

Table 3. LCD1 Pin Map

Pin COM3 COM2 COM1 COM0 COM3 COM2 COM1 COM0 Pin

1 DP7 7E 7G 7F X X X X X

2 7D 7C 7B 7A MEM MINUS ERR DOL 26

3 DP6 6E 6G 6F 8BC RX TX ENV 25

4 6D 6C 6B 6A A0 A1 A2 ANT 24

5 COL5 5E 5G 5F BB B0 B1 BT 23

6 5D 5C 5B 5A AL AD AR AU 22

7 DP4 4E 4G 4F P2 P1 P0 PL 21

8 4D 4C 4B 4A F4 F3 F2 F1 20

9 COL3 3E 3G 3F P3 P4 PR F5 19

10 3D 3C 3B 3A COM0 18

11 DP2 2E 2G 2F COM1 17

12 2D 2C 2B 2A COM2 16

13 DP1 1E 1G 1F COM3 15

14 1D 1C 1B 1A X X X X X

http://www.softbaugh.com/downloads/SBLCDA4_Specification.pdf
http://www.softbaugh.com/downloads/SBLCDA4_Specification.pdf
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32 Mbit Flash with SPI Bus

The Spansion S25FL032A 32 Mbit device, shown in Figure 17, is a 3.0 V (2.7 V to 3.6 V) 
single-power-supply Flash memory device that accepts data written to a serial input (SI) 
and outputs data on a serial output (SO). Upon installing the ZDS II software, refer to the 
following sample project folders for source code which can be used to read and program 
SPI Flash memory: 

..\BSP\Samples\AES\EncryptingDataLogger 

..\BSP\Samples\UART_SPI_M2M

The S25FL032A device can be found on the F6482 Series Development Board at location 
U2. The pin configuration of this device is shown in Figure 18; a close-up image is shown 
in Figure 19.

Figure 17. 32 MBit Flash with SPI Bus

Figure 18. S25FL032A Pin Configuration



UM026302-0916  MIC5318 Low Voltage Drop-Out Regulator

Z8 Encore! XP® F6482 Series Development Kit
User Manual

21

To learn more about this S25FL032A device, visit http://html.alldatasheet.net/html-pdf/
465962/SPANSION/S25FL032P_12/3944/10/S25FL032P_12.html.

MIC5318 Low Voltage Drop-Out Regulator

The on-board regulator is the MIC5318 Low Voltage Drop-Out Regulator. This device 
regulates the 5 V input voltage to the MCU’s VCC_T, which can be adjusted from 1.8 V to 
3.6 V using the R13 trim pot. Pin assignments, a circuit diagram, and an image of the 
MIC5318 device are shown in Figures 20 through 22.

Figure 19. U2 on the F6482 Series Development Board

Figure 20. MIC5318 Low Voltage Drop-Out Regulator Pin Assignments

http://html.alldatasheet.net/html-pdf/465962/SPANSION/S25FL032P_12/3944/10/S25FL032P_12.html
http://html.alldatasheet.net/html-pdf/465962/SPANSION/S25FL032P_12/3944/10/S25FL032P_12.html
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RE200B Pyroelectric Sensor

The RE200B pyroelectric sensor is made of a crystalline material that generates a surface 
electric charge when exposed to heat in the form of infrared radiation. A circuit diagram 
and an image of the RE200B device are shown in Figures 23 and 24.

Figure 21. The MIC5318 Low Voltage Drop-Out Regulator Circuit

Figure 22. The MIC5318 Low Voltage Drop-Out Regulator
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To learn more about this RE200B device, visit http://www.bucek.name/pdf/re200b.pdf.

Figure 23. RE200B Pyroelectric Sensor Circuit

Figure 24. The RE200B Pyroelectric Sensor

http://www.bucek.name/pdf/re200b.pdf
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TPA301D Mono Audio Power Amplifier

The TPA301 is a bridge-tied load (BTL) audio power amplifier developed especially for 
low-voltage applications in which internal speakers are required. Pin assignments, a cir-
cuit diagram, and an image of the TPA301D device are shown in Figures 25 through 27.

Figure 25. TPA301D Mono Audio Power Amplifier Pin Assignments

Figure 26. TPA301D Mono Audio Power Amplifier Circuit
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To learn more about this TPA301 device, visit http://www.ti.com/lit/ds/symlink/
tpa301.pdf

CVS-1508 Speaker

The CVS-1508 low-profile speaker manufactured by CUI Inc. consists of a 0.3 W, 8 Ω 
neodymium magnet and mylar cone housed in a 15 mm round frame. An image of the 
CVS-1508 device is shown in Figure 28.

To learn more about this CVS-1508 device, visit http://www.cui.com/product/resource/
cvs-1508.pdf.

Figure 27. The TPA301D Mono Audio Power Amplifier

Figure 28. The CVS-1508 Speaker

http://www.ti.com/lit/ds/symlink/tpa301.pdf
http://www.ti.com/lit/ds/symlink/tpa301.pdf
http://www.cui.com/product/resource/cvs-1508.pdf
http://www.cui.com/product/resource/cvs-1508.pdf
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TEFT4300 PhotoTransistor

The TEFT4300 phototransistor is a silicon NPN ambient light sensor with a high radiant 
sensitivity and a daylight blocking filter. A circuit diagram and an image of the TEFT4300 
device are shown in Figures 29 and 30.

To learn more about this TEFT4300 device, visit http://www.vishay.com/docs/81549/
teft4300.pdf.

Figure 29. TEFT4300 PhotoTransistor Circuit

Figure 30. The TEFT4300 PhotoTransistor

http://www.vishay.com/docs/81549/teft4300.pdf
http://www.vishay.com/docs/81549/teft4300.pdf
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LM285 Adjustable Micropower Voltage Reference

The 3-terminal LM285 micropower circuit manufactured by Texas Instruments is an 
adjustable band-gap voltage reference diode which can be found on the F6482 Develop-
ment Board at location VR1. Voltage references, a circuit diagram, and an image of the 
LM285 device are shown in Figures 31 through 33.

Figure 31. LM285 Adjustable Micropower Voltage Reference

Figure 32. LM285 Adjustable Micropower Circuit
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J16 DBG

The J16 DBG device connects the F6482 Series Development Kit to the PC through a 
debug tool. A circuit diagram and an image of the J16 DBG device are shown in 
Figures 34 and 35.

Figure 33. The LM285 Adjustable Micropower Device

Figure 34. The J16 DBG Circuit
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Jumper Settings

The functions of the F6482 Development Board’s six jumpers are described in Table 4.

Figure 35. The J16 DBG Device

Table 4. Jumper Settings 

Jumper 
Name Description State Function

Factory 
Setting

J1 VREF– IN GND is a source for VREF– IN

OUT External source could be connected, or PB3 can 
be used as a GPIO.

J2 VREF+ IN On-board source, 2.5 V, is VREF+. OUT

OUT Pin PB4 can be used as a GPIO, or the internal 
source of VREF can be output here.

J9 SPI Flash Select IN On-board SPI Flash can be used. IN

OUT PC1 can be used as a GPIO.

J19 Audio Disable IN On-board audio amplifier and speaker are dis-
abled.

OUT On-board audio amplifier and speaker are 
enabled.

OUT

J21 UART Configuration 1–2,  
5–6

UART0 enabled. IN

3–4,  
7–8

UART1 enabled.

J23 PIR Sensor Power 
Source

1–2 VCC_T IN

2–3 VBIAS
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ZDS II Flash Loader Utility

A Flash Loader utility can be accessed from the Tools menu in Zilog Developer Studio. 
With the Flash Loader, you can program the Z8F6482 MCU directly using the hex code 
generated from the ZDS II IDE; Figure 36 presents an example.

Z8F6482 Sample Projects

A number of sample projects are included with the ZDS II – Z8 Encore! v5.2.2 software, 
which can be downloaded for free from the Zilog Store. These sample projects will be 
accessible upon installation of ZDS II – Z8 Encore! v5.2.2; their locations are listed in 
Table 4.

Figure 36. An Example Flash Loader Screen
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F6482 Series Development Kit Documentation

The following documents are each associated to the F6482 Series of MCUs, and are avail-
able free for download from the Zilog website.

Table 5. Z8F6482 MCU Sample Projects

Description Installed Location

ledblink \samples\XP_F6482\XP_F6482_LedBlink_C

\samples\XP_F6482\XP_F6482_LedBlink_asm

Buzzer \samples\XP_F6482\XP_F6482_Buzzer

Demo \samples\XP_F6482\XP_F6482_Demo

LCD \samples\XP_F6482\XP_F6482_LCD

LightSensing \samples\XP_F6482\XP_F6482_LightSensing

Motion \samples\XP_F6482\XP_F6482_Motion

SMR_Demo \samples\XP_F6482\XP_F6482_SMR_Demo

Table 6. F6482 Series Development Kit Documentation

Description
Document 
ID Installed Location

F6482 Series Product Specification PS0294 Documentation\Chip_Documentation

F6482 Series Product Brief PB0246 Documentation\Chip_Documentation

eZ8 CPU User Manual UM0128 Documentation\Chip_Documentation

Z8 Encore! XP F6482 Series API Programmer’s 
Reference Manual

RM0064 Documentation\Technical_Articles

Z8 Encore! Design for Debug TN0036 Documentation\Technical_Articles

F6482 Series Development Kit User Manual UM0263 Documentation\Tools_Documentation

Ethernet SmartCable User Manual UM0207 Documentation\Tools_Documentation

Opto-Isolated USB SmartCable User Manual UM0195 Documentation\Tools_Documentation

USB SmartCable User Manual UM0181 Documentation\Tools_Documentation

http://www.zilog.com/docs/PB0246.pdf
http://www.zilog.com/docs/ps0294.pdf
http://www.zilog.com/docs/um0128.pdf
http://www.zilog.com/docs/z8encore/appnotes/tn0036.pdf
http://www.zilog.com/docs/devtools/UM0263.pdf
http://www.zilog.com/docs/devtools/UM0207.pdf
http://www.zilog.com/docs/z8encoremc/devtools/UM0195.pdf
http://www.zilog.com/docs/devtools/UM0181.pdf
http://www.zilog.com/docs/software/RM0064.pdf
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Appendix A. Schematic Diagrams
Figures 37 through 40 present schematic diagrams of the F6482 Series Development Board.

Figure 37. F6482 Series Development Board Schematic Diagram, #1 of 4
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Figure 38. F6482 Series Development Board Schematic Diagram, #2 of 4
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Figure 39. F6482 Series Development Board Schematic Diagram, #3 of 4
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Figure 40. F6482 Series Development Board Schematic Diagram, #4 of 4
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Appendix B. Installing the USB 
SmartCable Driver

The USB SmartCable can be installed on PCs that run on Windows 7 (32- and 64-bit), 
Windows Vista (32- and 64-bit) and Windows XP operating systems. The procedures in 
this section will guide you through the USB SmartCable installation process.

Windows 7 32/64 Systems

Observe the following steps to install the USB SmartCable on a Windows 7 system.

1. Connect the USB SmartCable to a USB port on your development PC. When the PC 
detects the new hardware, it will display the Installing device driver software dialog.

2. Windows automatically searches for the driver; this process can take a few moments. 
Because there is no option to terminate this search process, wait for the search to com-
plete. If the driver was previously installed, Windows will automatically install the 
USB SmartCable driver. If this is the case, skip ahead to Step 9. If Windows cannot 
find the driver, close the search dialog and proceed to the next step.

3. In the Search programs and files field in the Windows Start menu, enter Device 
Manager. The Device Manager will appear in a list of search results.

4. From this list of results, click Device Manager to open the Device Manager dialog, 
which presents a list of devices that operate on your PC. Find and toggle Other 
devices to view a sublist of additional devices, and right-click your mouse on USB 
SmartCable.

5. In the submenu that appears, click Update Driver Software....

6. In the Update Driver Software – USB SmartCable dialog that appears, click the 
Browse my computer for driver software option.

7. Click the Browse... button to browse to one of the following driver directories, 
depending on the configuration of your PC.

On 32-bit Windows 7 systems, navigate to:

<ZDS II Installation Directory>\device drivers\USB\x32  
<ZDS II Installation CD>\device drivers\USB\x32

On 64-bit Windows 7 systems, navigate to:

<ZDS II Installation Directory>\device drivers\USB\x64 
<ZDS II Installation CD>\device drivers\USB\x64
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8. Click Next to install the driver. On 32-bit Windows systems, a security dialog will 
appear; select Install this driver software anyway.

9. After the Wizard finishes the installation, click Close.

Windows Vista 32/64 Systems

Observe the following steps to install the USB SmartCable on a Windows Vista system.

1. Connect the USB SmartCable to a USB port on the development PC.

2. After the PC detects the new hardware, it will display the Found New Hardware Wiz-
ard dialog box. Click Locate and install driver software (recommended).

3. Depending on your development PC’s User Account Control settings, Windows may 
ask for permission to continue the installation. Click Continue.

4. When the Insert the Disc dialog appears, select I don’t have the disc. Show me 
other options. Click the Next button to display the Windows couldn’t find driver dia-
log.

5. Select Browse my computer for driver software (advanced) to display the Browse 
For Driver dialog, which prompts you to key in or browse for the location of the 
driver’s .inf file. Depending on the type of computer you use (32- bit or 64-bit), use 
the Browse... button to navigate to one of the following paths, then click the Next but-
ton.

On 32-bit Vista systems, navigate to:

<ZDS II Installation>\device drivers\USB\x32 
<ZDS II Installation CD>\device drivers\USB\x32

On 64-bit Vista systems, navigate to:

<ZDS II Installation>\device drivers\USB\x64 
<ZDS II Installation CD>\device drivers\USB\x64

6. When the Windows Security dialog prompts you whether to install or not to install, 
click Install this driver software anyway and wait until the installation is completed 
(Windows may prompt you more than once).

7. When the software has been installed successfully, click Close.

Windows XP-32(SP3) Systems

Observe the following steps to install the USB SmartCable on a Windows XP system.

1. Connect the USB SmartCable to a USB port on the development PC. When the PC 
detects the new hardware, it will display the Found New Hardware Wizard dialog.
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2. In the Wizard, select Install from a list or specific location (Advanced), then click 
Next.

If the Windows Hardware Installation dialog appears, click Continue Anyway.

3. In the Please choose your search and installations dialog, select Search for the 
best driver in these locations and include this location in search.

4. Use the Browse... button to navigate to one of the following paths:

<ZDS II Installation>\device drivers\USB\x32 
<ZDS II Installation CD>\Device Drivers\USB\x32

5. Click Next to locate the appropriate driver.

6. Click Next a second time, then click Finish to complete the installation.

Note:
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Appendix C. Tera Term Configuration
If you are using Tera Term as your console program, observe the following procedure to 
properly configure it.

1. Please refer to page 12 section Hyper Terminal Configuration on how to connect a 
USB to TTL serial converter between the development board and your host PC.

2. In Tera Term, and if your PC has a serial interface, navigate via the Setup menu to 
Serial port… to select the COM port assigned to your serial port. If you do not have a 
serial port on your PC, use a USB-to-serial adapter (not included in the kit). 

3. Use the Ports (COM & LPT) listing in the Device Manager to determine the correct 
COM port assigned to your adapter. Configure this port to reflect the following set-
tings:

– 57600 bps 

– 8 data bits 

– No parity 

– 1 stop bit

– No flow control 

4. Click the OK button to connect to the F6482 Development Board. Upon connection, 
you should be able to see the demonstration program menu shown in Figure 11 on 
page 12.
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Customer Support

To share comments, get your technical questions answered, or report issues you may be 
experiencing with our products, please visit Zilog’s Technical Support page at http://sup-
port.zilog.com.

To learn more about this product, find additional documentation, or to discover other fac-
ets about Zilog product offerings, please visit the Zilog Knowledge Base or consider par-
ticipating in the Zilog Forum.

This publication is subject to replacement by a later edition. To determine whether a later 
edition exists, please visit the Zilog website at http://www.zilog.com.

http://www.zilog.com/kb
http://www.zilog.com/forum
http://www.zilog.com
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